Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

⚠️ **DANGER**

indicates that death or severe personal injury will result if proper precautions are not taken.

⚠️ **WARNING**

indicates that death or severe personal injury may result if proper precautions are not taken.

⚠️ **CAUTION**

indicates that minor personal injury can result if proper precautions are not taken.

**NOTICE**

indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

⚠️ **WARNING**

Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1 Security information..............................................................................................................................5
2 Preface..................................................................................................................................................7
3 Using SIMATIC SIS compact..............................................................................................................9
4 System requirements............................................................................................................................11
   4.1 Hardware requirements..............................................................................................................11
   4.2 Software requirements..............................................................................................................14
5 Licenses...............................................................................................................................................15
6 Detailed features of SIMATIC SIS compact........................................................................................17
   6.1 Properties..................................................................................................................................17
   6.2 Engineering functions..............................................................................................................17
   6.3 Operator station (WinCC) functions.......................................................................................19
7 Installation of SIMATIC SIS compact..................................................................................................21
   7.1 Installing SIMATIC SIS compact............................................................................................21
   7.2 Available software packages....................................................................................................22
8 Configurations in SIMATIC SIS compact............................................................................................25
   8.1 System configurations..............................................................................................................25
   8.2 Configurations examples............................................................................................................27
9 Communication in SIMATIC SIS compact..........................................................................................31
10 Project migration from SIMATIC SIS compact to SIMATIC PCS 7....................................................33
A Appendix..............................................................................................................................................35
   A.1 Comparison between CPU 410-5H and CPU 410SIS..........................................................35
   A.2 Additional possibilities of AS-AS communication and interfaces.........................................35
   A.3 Reference manuals......................................................................................................................36
Index..........................................................................................................................................................37
Siemens provides products and solutions with industrial security functions that support the secure operation of plants, systems, machines, and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. Siemens’ products and solutions only form one element of such a concept.

Customer is responsible to prevent unauthorized access to its plants, systems, machines and networks. Systems, machines and components should only be connected to the enterprise network or the internet if and to the extent necessary and with appropriate security measures (e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be taken into account. For more information about industrial security, please visit:


Siemens’ products and solutions undergo continuous development to make them more secure. Siemens strongly recommends to apply product updates as soon as available and to always use the latest product versions. Use of product versions that are no longer supported, and failure to apply latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed under

Introduction to SIMATIC SIS compact

SIMATIC SIS compact is designed for use in dedicated Safety Instrumented Systems (SIS) for critical process industries, for example, Burner Management System (BMS), Fire and Gas (F&G) industries, Emergency ShutDown (ESD) applications. SIMATIC SIS compact provides functional safety and protects human, environment, and factory against hazardous events by bringing the process to a safe state in the case of a critical process situation.

The SIMATIC SIS compact system is based on selected system components of SIMATIC PCS 7 and the SIMATIC Safety Integrated product portfolio (SIMATIC S7 F Systems and SIMATIC Safety Matrix). It is an easy-to-use system designed for cost-efficient functional safety solutions for small to mid-size plant configurations.

Starting with one of the available predefined bundle sets, you can build a fail-safe application and benefit from the advantages of automation technology with this system.

Purpose of this documentation

This document guides you through the basics of SIMATIC SIS compact. You will get to know the elementary configuration steps and develop an understanding of SIMATIC SIS compact and its functionalities.

Required basic knowledge

General knowledge in the area of automation engineering, basic knowledge of SIMATIC PCS 7, SIMATIC S7 F Systems, and SIMATIC Safety Matrix is required to understand this documentation.

Guide

The SIMATIC SIS compact documentation also includes references to the SIMATIC PCS 7 documentation. This enables you to quickly access the required documentation.

Accessing SIMATIC documentation

The relevant versions of the documentation for SIMATIC SIS compact, SIMATIC PCS 7, SIMATIC S7 F Systems, and SIMATIC Safety Matrix are available on the Internet pages of the "SIMATIC PCS 7 Technical Documentation (www.siemens.com/pcs7-documentation)".

SIMATIC SIS compact Readme (offline)

The offline version of the Readme file is installed during the SIMATIC SIS compact installation. This file only contains general notes and references to documents on the internet.
SIMATIC SIS compact Readme (online)

The online version of the Readme file contains all information on the installation and use of SIMATIC SIS compact. This file is available only on the internet. You can find the current version of this document for download under the entry ID 109749427 in the Industry Online Support:

Internet link (https://support.industry.siemens.com/cs/ww/en/view/109749427)

Note

It is vital that you use the information from the most recent version of the SIMATIC SIS compact Readme (online) before you begin the installation or use of SIMATIC SIS compact V9.0.

SIMATIC documentation on the Internet (current versions)

The latest documentation on the SIMATIC PCS 7 version is available on the Internet page "Technical Documentation SIMATIC PCS 7."

- In the section "Software Manuals SIMATIC PCS 7 ..."
  - The link to the latest system and product documentation of the particular PCS 7 version.
  - The link to download the Setup for the latest system documentation "PCS 7 Documentation Portal Setup" (SIMATIC PCS 7 online help).

Note

SIMATIC SIS compact V9.0 does not have a specific or adapted online help.

- The link to download the entire SIMATIC PCS 7 documentation as a Manual Collection in the My Documentation Manager (http://support.industry.siemens.com/cs/ww/en/view/59538371).

The Manual Collection includes the manuals for hardware and software.

Conventions

The names of software interface elements are specified in the same language used for this documentation. If you have installed a multi-language package for the operating system, some of the designations will still be displayed in the basic operating system language, even after changing the language. They will therefore differ from the designations used in the documentation.

If you use the operating system Windows 10, you can find the Siemens SIMATIC programs in the Start menu under All apps > Siemens Automation.
SIMATIC SIS compact fail-safe systems

SIMATIC SIS compact fail-safe automation systems are used in the systems with stringent safety requirements. The objective of SIMATIC SIS compact is to control processes with an immediately achievable safe state. In other words, SIMATIC SIS compact controls processes in which an immediate shutdown does not endanger people or the environment.

Achievable safety requirements

With SIMATIC S7 F/FH Systems as part of SIMATIC SIS compact, you can achieve the following safety requirements:

- Safety Integrity Level SIL3 according to IEC 61508:2010
- Performance Level (PL) e and Category 4 according to ISO 13849-1:2015 or EN ISO 13849-1:2015

The principle of safety functions in SIMATIC SIS compact

Functional safety is implemented principally through safety functions in the software. Safety functions are performed by SIMATIC SIS compact whenever a dangerous event occurs:

- To place the system in a safe state or
- To keep the system in a safe state

Safety functions are contained mainly in the following components:

- In the safety-related user program (safety program) in the CPU 410SIS
- In the fail-safe inputs and outputs (F-I/O)

The F-I/O ensures safe processing of field information (such as temperature and level monitoring). They have all of the required hardware and software components for safe processing, in accordance with the required safety class. You only have to program the user safety function. The safety function for the process can be provided through a user safety function or a fault reaction function. In the event of a fault, if the F System can no longer execute its actual user safety function, it executes the fault reaction function.

Fail-safety and availability

To increase availability of the automation system and, thus, to prevent process failures due to faults in the CPU 410SIS, you can optionally equip fail-safe systems with a fault-tolerant feature. You achieve this increased availability through component redundancy:

- Power supply (PS)
- Central processing unit (CPU)
- Communication
- F-I/O
With fail-safe, high-availability CPU 410SIS, you can resume production without harming people or the environment.

**SIMATIC Safety Matrix - Comprehensive tool for safety life cycle**

SIMATIC Safety Matrix is a comprehensive tool for safety life cycle engineering and management of CPU 410SIS fail-safe automation systems and provides support for all phases of the safety life cycle:

- SIMATIC Safety Matrix is a configuring tool for processes that require safety-related reactions to defined conditions.
- With SIMATIC Safety Matrix, a CFC safety program can be created for CPU 410SIS according to the rules of a cause/effect matrix.
- SIMATIC Safety Matrix is an integrated tool for all activities, maintenance, error handling, and change management during operation.
4.1 Hardware requirements

SIMATIC SIS compact CPU

SIMATIC SIS compact V9.0 supports the following S7-400 CPU:

CPU 410SIS - MLFB: 6ES7 410-5FM08-0AB0

Automation system (AS)

The following modules are available in the SIMATIC SIS compact environment:
1. Rack - All racks that are supported in SIMATIC PCS 7 V9.0 environment
2. Power Supply - All power supplies that are supported in SIMATIC PCS 7 V9.0 environment
3. CPU 410SIS

Two predefined AS bundles with CPU 410SIS are available for SIMATIC SIS compact:
- Single (MLFB: 6ES7 654-6FD00-7AF0)
- Redundancy (MLFB: 6ES7 656-6FD30-7AF0)

The following table provides the details of the components available in the pre-defined bundles that can be used in a SIMATIC SIS compact environment:

<table>
<thead>
<tr>
<th>Component</th>
<th>Details</th>
<th>Quantity in the bundle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
<td>CR3 XTR, 4 slots (MLFB: 6ES7 401-1DA01-0AA1)</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>Power supply</td>
<td>PS 407 4A XTR S7-400 (MLFB: 6ES7 407-0DA02-0AA1)</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>CPU</td>
<td>• CPU 410SIS V8.2 (MLFB: 6ES7 410-5FM08-0AB0)&lt;br&gt;• SEC E4MB (MLFB: 6ES7 653-2DD00-0X80)</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>Sync. Module Set</td>
<td>Sync. module set (MLFB: 6ES7656-7XX30-0XE0); Consists of 4 X 10M Sync Module (IF960) and 2 X 1M Fibre Optic</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>
System Expansion Card (SEC)

The CPU 410SIS is equipped with the system expansion card SEC E4MB which enables 4 MB memory. The system expansion card forms a hardware unit with the CPU 410SIS. In redundant operation, you use two CPU 410SIS that are each equipped with a SEC E4MB. The CPU 410SIS will not change into RUN mode with any other system expansion card.

Remote I/O stations

In SIMATIC SIS compact environment as remote I/O stations, ET 200M and ET 200iSP connected via PROFIBUS DP are supported.

<table>
<thead>
<tr>
<th>Remote I/O Stations</th>
<th>Interface Module</th>
<th>Supported I/O modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>• Fail-safe modules¹</td>
</tr>
<tr>
<td></td>
<td>(MLFB: 6ES7 153-2BA70-0XB0)</td>
<td>• Maximum of two non-fail-safe modules² for each ET 200M station</td>
</tr>
<tr>
<td>ET 200iSP</td>
<td>IM 152-1</td>
<td>• Fail-safe modules¹</td>
</tr>
<tr>
<td>(Firmware version &gt;= 2.0)</td>
<td>(MLFB: 6ES7 152-1AA00-0AB0)</td>
<td>• Maximum of two non-fail-safe modules² for each ET 200iSP station</td>
</tr>
</tbody>
</table>


² All modules of ET 200M/ET 200iSP which are released for SIMATIC PCS 7 V9.0. For further information, refer to SIMATIC PCS 7 Released modules (V9.0) (https://support.industry.siemens.com/cs/ww/en/view/109748745).

High-precision time stamping - Sequence of Events (SoE)

One feature of SIMATIC SIS compact is high-precision time stamping. This feature provides the chronological sequence of events. The following table lists the ET 200 I/O modules that support high-precision time stamping and are supported by SIMATIC SIS compact:

<table>
<thead>
<tr>
<th>Distributed I/O device</th>
<th>Module</th>
<th>Article number</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7 321-7BH01-0AB0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>High-precision with accuracy of 1 ms</td>
</tr>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7 321-7EH00-0AB0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>High-precision with accuracy of 1 ms</td>
</tr>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7 321-7RD00-0AB0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accuracy of 10 ms</td>
</tr>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7 321-7TH00-0AB0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accuracy of 10 ms</td>
</tr>
<tr>
<td>ET 200M</td>
<td>SM 326</td>
<td>6ES7 326-1BK02-0AB0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accuracy of 20 to 30 ms</td>
</tr>
</tbody>
</table>
### Gateway

A Y Link is required to connect SIMOCODE DP and SINAMICS drives with a single DP interface to a redundant CPU 410SIS. SIMATIC SIS compact supports the following Y Link:

**Y Link - MLFB 6ES7197-1LA12-0XA0**

This Y Link includes:
- 2 x IM 153-2 (MLFB: 6ES7153-2BA70-0XB0)
- 1 x Bus module IM/IM (MLFB: 6ES7195-7HD80-0XA0)
- 1 x Y coupler (MLFB: 6ES7197-1LB00-0XA0)
- 1 x Bus module Y coupler (MLFB: 6ES7654-7HY00-0XA0)

For more information on Y Link, refer to SIMATIC Bus links DP/PA coupler, active field distributor, PA Link and Y Link ([https://support.industry.siemens.com/cs/ww/en/view/1142696](https://support.industry.siemens.com/cs/ww/en/view/1142696)).

### SIMOCODE

The following fail-safe variants of SIMOCODE Pro DP are supported in SIMATIC SIS compact:
- SIMOCODE pro V (Safety technology) (PDM) (MLFB: 3UF7 010-1A*00-0)
- SIMOCODE pro V (GSD V1.5) (MLFB: 3UF7 010-1A*00-0)

There is no limitation concerning the usable modules (universal, PROFISafe) of a configured SIMOCODE DP.

**Note**

The SIMOCODE modules are only visible after the installation of SIMATIC PDM with imported device library. The necessary SIMOCODE Pro Library V9.0 is not included in the SIMATIC SIS compact software package.

### SINAMICS drives

SIMATIC SIS compact supports the following most commonly used SINAMICS G120 PROFIBUS drives:

<table>
<thead>
<tr>
<th>Drives</th>
<th>MLFB</th>
</tr>
</thead>
<tbody>
<tr>
<td>G120 CU240E-2 DP</td>
<td>6SL3 244-xxxx2-xPxx</td>
</tr>
<tr>
<td>G120 CU240E-2 DP F</td>
<td>6SL3 244-xxxx3-xPxx</td>
</tr>
<tr>
<td>G120 CU240S DP F</td>
<td>6SL3 244-0BA21-1PA0</td>
</tr>
</tbody>
</table>
### Drives

<table>
<thead>
<tr>
<th>Drives</th>
<th>MLFB</th>
</tr>
</thead>
<tbody>
<tr>
<td>G120 CU250S-2 DP Vector</td>
<td>6SL3 246-xxxx2-xPxx</td>
</tr>
<tr>
<td>G120C DP</td>
<td>6SL3 210-1KExx-xxPx</td>
</tr>
<tr>
<td>G120D CU240D-2 DP</td>
<td>6SL3 544-xxxx0-xPxx</td>
</tr>
<tr>
<td>G120D CU240D-2 DP F</td>
<td>6SL3 544-xxxx1-xPxx</td>
</tr>
<tr>
<td>G120D CU250D-2 DP F</td>
<td>6SL3 546-xxxx1-xPxx</td>
</tr>
</tbody>
</table>

### Note

The SINAMICS modules are only visible after the installation of the Drive ES software package, Drive_ES_PCS7_APL_Vxx. Drive ES software is not included in the SIMATIC SIS compact software package.

---

### 4.2 Software requirements

#### Operating systems

SIMATIC SIS compact supports the following operating systems:

- Windows 7 Professional SP1 (64-Bit, English version only)
- Windows 7 Ultimate / Enterprise SP1 (64-Bit)
- Windows 10 Enterprise 2015 LTSB (64-Bit)
License Bundles

The SIMATIC SIS compact licenses are provided with the following available SIS compact license bundles:

<table>
<thead>
<tr>
<th>License Bundle</th>
<th>Product components available</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS Engineering SIS compact V9.0 (SL)</td>
<td>Contains CFC + STEP 7 licenses</td>
</tr>
<tr>
<td>ES Single Station SIS compact User V9.0 (SL)</td>
<td>Contains CFC + STEP 7 licenses</td>
</tr>
<tr>
<td>OS Single Station SIS compact V9.0 (SL)</td>
<td>Contains WinCC licenses</td>
</tr>
<tr>
<td>OS Single Station SIS compact Redundancy V9.0 (SL)</td>
<td>Contains WinCC licenses</td>
</tr>
<tr>
<td>ES Single Station SIS compact System V9.0 (SL)</td>
<td>Contains WinCC licenses</td>
</tr>
</tbody>
</table>

Note
All bundle licenses are standard licenses of the type "Single License" and therefore cannot be used from multiple locations via network (License-server).

Note
SIMATIC SIS compact does not come with a trial period license.

SIMATIC SIS compact License Key USB Hardlock

SIMATIC SIS compact V9.0 comes with a license key USB Hardlock specially designed for SIS compact. This USB Hardlock must be permanently plugged into the computer while running the SIMATIC SIS compact V9.0 software.

- The SIMATIC Manager (STEP 7) cannot be opened without a valid USB Hardlock and is forced to close if the USB Hardlock is unplugged or breaks down.
- If the USB Hardlock is unplugged or breaks down during operator station (OS) process mode operation (WinCC Runtime is activated), the system would still be operable (WinCC Demo-Mode).
Detailed features of SIMATIC SIS compact

6.1 Properties

Overview of SIMATIC SIS compact properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported CPU</td>
<td>CPU 410SIS</td>
</tr>
</tbody>
</table>
| Process objects (POs)     | - OS process objects: Maximum of 2400 POs per OS project on one OS single station system  
                            - AS process objects: Maximum of 2400 AS RT PO per project               |
| WinCC object manager      | Maximum of 8 operator stations are supported that includes:             |
|                           | - 2 OS in one redundant operator station                                 |
|                           | - Maximum of 6 reference OS                                             |
| Project wizard            | - CPU 410SIS                                                            |
|                           | - Single station projects                                               |
| Project settings          | Single station projects                                                 |
| Block List Editor         | Read-only                                                               |
| Text Library              | - English, German and Chinese (simplified) are supported                |
|                           | - Read-only                                                             |
| Component List Editor     | Read-only                                                               |
| OS project editor         | - Maximum of two screens per OS station are supported                   |
|                           | - Single station projects                                               |
| Script Editor             | Read-only                                                               |
| VBA support               | Mass data engineering is not supported                                  |
| Archiving cycle           | Minimum archiving cycle time is up to 500 ms                            |
| OS channels               | - "Named Connections" (PA CPU)                                          |
|                           | - OPC UA/DA/A&E/HAD (third party)                                      |
|                           | - PROFIBUS                                                              |

6.2 Engineering functions

Engineering system

The engineering system is structured on matching applications, facilitating the central, project-wide engineering of all the components on a SIMATIC SIS compact configuration:

- Configuration of the hardware and field devices (HWConfig, SIMATIC PDM)
- Configuration of the communications networks (NetPro)
• Configuration of continuous function chart (CFC)
• Design of the operator control and monitoring strategies (WinCC Graphics Designer)

The central engineering for all SIMATIC SIS compact components is performed on the engineering station (ES):
• Operator stations
• Automation systems (CPU 410SIS)
• Distributed I/O

Multiprojects

You can only create one single station OS project.

AS-OS Engineering

SIMATIC SIS compact checks the number of process objects during data transmission to the OS (WinCC). If the number of process objects is more than 2400, the data transfer is not possible. In this case, reduce the number of configured process objects and transfer the data once more.

Possible connection types between ES and OS

You can configure a connection between ES and OS in NetPro using:
• S7 channels
  – Named connections (for CPU 410SIS)
  – PROFIBUS (for usage with PLCSim)
• All OPC channels (can only be used on OS, not between ES and OS)

The usage of any other connection type is terminated when the AS-OS transfer is aborted.

SIMATIC SIS compact project wizard

The SIMATIC SIS compact project wizard supports you during the project creation. You can create single station projects with CPU 410SIS using the project wizard.
STEP 7 - User interface

The following functions are not available in the SIMATIC SIS compact user interface, which means they are displayed as grayed out only:

<table>
<thead>
<tr>
<th>Software product</th>
<th>Menu command</th>
</tr>
</thead>
</table>
| SIMATIC Manager  | • File > S7 memory card  
|                  | • PLC > Manage M7 system  
|                  | • PLC > Copy RAM to ROM  
|                  | • Insert > Station > SIMATIC-.300 station  
|                  | • Insert > Station > SIMATIC S5  
|                  | • Edit > Project properties → dialog box in "Type" area - the "STEP 7" option cannot be selected  
|                  | • Options > CAx data  
|                  | • Options > Shared Declarations > Synchronize in Multiproject  
|                  | • Project node selected: Insert New Object > Foundation Fieldbus  
| HardwareConfig   | • Station > Import  
|                  | • Station > Export  
|                  | • PLC > Upload  
| NetPro           | • Edit > Import  
|                  | • Edit > Export  

6.3 Operator station (WinCC) functions

Operator station

You can operate and monitor your SIMATIC SIS compact system in the process mode on the operator station.

Mass data engineering

The use of mass data engineering with VBA in Graphics Designer is not supported. You can use the script languages VBS and ANSI-C in the process pictures without restrictions.

Archiving process data

The number of archived values for each OS single station system should not exceed 500 values per second.
OS interfaces

You can use the following interfaces in the WinCC Explorer:

<table>
<thead>
<tr>
<th>Connection name</th>
<th>Area of application</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7 channels:</td>
<td></td>
</tr>
<tr>
<td>● Named connections</td>
<td>● For CPU 410SIS</td>
</tr>
<tr>
<td>● PROFIBUS</td>
<td>● For simulating CPU 410SIS with PLCSim</td>
</tr>
<tr>
<td>All OPC channels (UA, DA, A&amp;E, HDA)</td>
<td>For data access to third party or between two OSs</td>
</tr>
<tr>
<td>WinCC Sysinfo channel</td>
<td>For OS diagnostics and system information</td>
</tr>
</tbody>
</table>
7

Installation of SIMATIC SIS compact

7.1 Installing SIMATIC SIS compact

Language combinations for setup

The SIMATIC SIS compact setup offers the following language configurations:

<table>
<thead>
<tr>
<th>Microsoft Windows system language</th>
<th>Selected user interface language in SIMATIC SIS compact setup</th>
<th>Languages available for SIMATIC SIS compact</th>
<th>Language of the installed libraries</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chinese (simplified)</td>
<td>English</td>
<td>English (default)</td>
<td>English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chinese (optional)</td>
<td></td>
</tr>
<tr>
<td>Chinese (simplified)</td>
<td>Chinese (simplified)</td>
<td>English (default)</td>
<td>Chinese (simplified)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chinese (default)</td>
<td></td>
</tr>
<tr>
<td>English</td>
<td>English</td>
<td>English (default)</td>
<td>English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>German (optional)</td>
<td></td>
</tr>
<tr>
<td>English</td>
<td>German</td>
<td>German (default)</td>
<td>English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>English (default)</td>
<td></td>
</tr>
<tr>
<td>German</td>
<td>German</td>
<td>German (default)</td>
<td>English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>German (default)</td>
<td></td>
</tr>
<tr>
<td>German</td>
<td>English</td>
<td>English (default)</td>
<td>English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>German (optional)</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

SIMATIC S7 F Systems and SIMATIC Safety Matrix are supported in English and German.

Installation of SIMATIC SIS compact

Double-click the Setup.exe file on the installation disk and follow the instructions in the "Setup" window.

**Note**

**Readme files**

Refer to the Readme files of SIMATIC S7 F Systems and SIMATIC Safety Matrix to know the system requirements before starting the installation. The Readme files are available in the installation DVD folder of SIMATIC SIS compact.

The following image shows the available program packages:
## 7.2 Available software packages

**Software packages**

SIMATIC SIS compact V9.0 comes with the following software packages:

<table>
<thead>
<tr>
<th>Included components/products</th>
<th>SIMATIC SIS compact setup packages</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SIMATIC SIS compact Engineering</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SIMATIC SIS compact Runtime</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Options</td>
<td></td>
</tr>
<tr>
<td>ES installation (STEP 7, CFC, …)</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>OS Single Station installation (WinCC, Faceplates, …)</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>SIMATIC PDM</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>SIMATIC OpenPCS 7</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SIMATIC Logon</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SIMATIC S7 F Configuration Pack</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>
### Included components/products

<table>
<thead>
<tr>
<th>SIMATIC SIS compact setup packages</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC SIS compact Engineering</td>
<td></td>
</tr>
<tr>
<td>SIMATIC SIS compact Runtime</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Included components/products</th>
<th>SIMATIC SIS compact Engineering</th>
<th>SIMATIC SIS compact Runtime</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC S7 F Systems</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SIMATIC S7 Safety Matrix</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>
Installation of SIMATIC SIS compact

7.2 Available software packages
8.1 System configurations

Minimum configuration

The following figure shows an example of the minimum system configuration in SIMATIC SIS compact:

![Diagram of minimum configuration]

**Note**

**OS simulation on an engineering station**

An OS simulation on an engineering station requires an OS runtime license.
Maximum configuration

The following figure shows an example of the maximum system configuration in SIMATIC SIS compact:

![Diagram of maximum configuration](image)

The architecture can be as follows:

- 1 OS single station system and up to 6 additional OS single station system references
- 1 redundant OS single station system and up to 6 additional OS single station system references

Note

SIMATIC SIS compact supports the usage of Process Historian. Thereby, you can archive the OS data in a Process Historian from the SIMATIC SIS compact OS Single Station.

Selecting components to be used in your plant

You can find information on selecting system components in the chapter "Components of a PCS 7 system" of the manual "Engineering System" located in documentation [www.siemens.com/pcs7-documentation](http://www.siemens.com/pcs7-documentation) "Software Manuals SIMATIC PCS 7", > "SIMATIC PCS 7 System Documentation".
8.2 Configurations examples

SIMATIC SIS compact in a small plant

The architecture shows an example of a small plant configuration (single station automation system). In this configuration, the engineering station is connected through S7 named connections to the CPU 410SIS.

- The I/O module of ET 200M are connected to the CPU using a PROFIBUS DP.
- Connection to third party Distributed Control System (DCS) via Modbus is possible.

SIMATIC SIS compact in a mid-size plant

The architecture shows an example of a medium plant configuration (single station automation system and an optional operator station). In this configuration, both engineering station and operator station are connected through S7 named connections to the CPU 410SIS.

- The I/O modules of ET 200M and ET 200iSP are connected to the CPU using a PROFIBUS DP.
- Connection to third party DCS via Modbus is possible.
SIMATIC SIS compact in a large plant

The architecture shows an example of a large plant configuration.

- Connection to third party DCS via Modbus is possible.
- Safety integrated SIMOCODE pro V devices and SINAMICS drives (G120C) can be configured.
Configurations in SIMATIC SIS compact

8.2 Configurations examples

SIS compact V9.0
Operating Instructions, 08/2017, A5E39746613-AA
Communication in SIMATIC SIS compact

Communication security

It is recommended to secure the unused interfaces of the CPU to protect it against misusage, for example, by activating the Field Interface Security.

In SIMATIC SIS compact, you can improve communication security as follows:

- The plant and terminal bus communication by using CP1628 and SCALANCE S devices.
- The fieldbus communication by activating Field Interface Security.
- Modbus communication by using SCALANCE S devices.

Project migration from SIMATIC SIS compact to SIMATIC PCS 7

Migrating projects from SIMATIC SIS compact to SIMATIC PCS 7

You can migrate SIMATIC SIS compact projects to SIMATIC PCS 7 projects. This migration requires the change of CPU physically and also in the HWConfig.

Prerequisite

Ensure that the version of PCS 7 software components is equal or higher than the SIS compact software components.

Procedure

1. Create a backup of your SIS compact project data.
2. Remove CPU 410SIS both physically and from the HWConfig.
   
   **Note**
   
   Do not delete the program and PROFIBUS connections while removing the CPU 410SIS from the HWConfig.

3. Delete all communication connections from NetPro.
4. Archive your SIS compact project.
5. Insert the archived SIS compact project in the PCS 7 multiproject path.
6. Insert the new CPU both physically and in the HWConfig. For example, CPU 410-5H.
7. Configure required settings in the new CPU.
8. Assign the existing PROFIBUS/Modbus connection to the new CPU.
9. Assign existing program folder to the new CPU.
10. Make required configuration settings to complete the project migration. For example, NetPro settings, CFCs, FBs.
Appendix

A.1 Comparison between CPU 410-5H and CPU 410SIS

<table>
<thead>
<tr>
<th>Components</th>
<th>CPU 410-5H (V8.2) MLFB: 6ES7 410-5HX08-0AB0</th>
<th>CPU 410SIS (V8.2) MLFB: 6ES7 410-5FM08-0AB0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main memory (MB)</td>
<td>32 (16/16)</td>
<td>4</td>
</tr>
<tr>
<td>System expansion card</td>
<td>SECs with different PO counts</td>
<td>SEC E4MB</td>
</tr>
<tr>
<td>Online PO upgrade</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>I/O amount</td>
<td>DP: Each E/A 6 KB</td>
<td>Each interface max. 1536 Byte</td>
</tr>
<tr>
<td></td>
<td>X5/X8: Each E/A 8 KB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total: 16384 Byte</td>
<td></td>
</tr>
<tr>
<td>Amount PROFIBUS DP Slaves / PROFINET I/O Devices</td>
<td>96 Slaves / 2x256 Devices</td>
<td>96 Slaves</td>
</tr>
<tr>
<td>Support of central modules</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Fail-safe</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

A.2 Additional possibilities of AS-AS communication and interfaces

The following are the possible AS-AS communication and interfaces to communicate with SIMATIC SIS compact:

- **Communication with SIMATIC H CPUs using Modbus**
  - For information on block library for a redundant Modbus/TCP communication over the integrated PN interface of a SIMATIC H CPU, refer to: Internet link (https://support.industry.siemens.com/cs/ww/en/view/103475102)
  - For information on SIMATIC Modbus/TCP redundant communication via the integrated PN interface of H-CPUs, refer to: Internet link (https://support.industry.siemens.com/cs/ww/en/view/103498202)

- **Communication between SIMATIC SIS compact and S7-300 and/or S7-400 standard**
  - For information on how to configure a specified and an unspecified S7 connection for data exchange between S7-300 and/or S7-400 by using Industrial Ethernet CPs, refer to: Internet link (https://support.industry.siemens.com/cs/ww/en/view/17628518)
  - For information on how to send data with PCS 7 to an H CPU that has not been configured in the same multiproject, refer to: Internet link (https://support.industry.siemens.com/cs/ww/en/view/43033406)
<table>
<thead>
<tr>
<th>Ref. no.</th>
<th>Manual</th>
<th>URL</th>
</tr>
</thead>
</table>
# Index

## A
- Achievable safety requirements
  - SIMATIC SIS compact, 9
- Archiving
  - OS, 19
- AS
  - SIMATIC SIS compact, 11
- AS-OS Engineering
  - ES, 18

## B
- bundles
  - SIMATIC SIS compact, 11

## C
- Communication security
  - SIMATIC SIS compact, 31
- CPU
  - SIMATIC SIS compact, 11

## E
- ES
  - AS-OS Engineering, 18
  - ES OS connection, 18
  - Multiprojects, 18
  - Project wizard, 18
  - ES OS connection
    - ES, 18

## F
- Fail-safe systems
  - SIMATIC SIS compact, 9
- Fail-safety and availability
  - SIMATIC SIS compact, 9

## G
- Gateway
  - SIMATIC SIS compact, 13

## H
- High-precision time stamping
  - SIMATIC SIS compact, 12

## I
- Installation
  - SIMATIC SIS compact, 21
- Interfaces
  - OS, 20

## L
- License Bundles
  - SIMATIC SIS compact, 15
- License Key USB Hardlock
  - SIMATIC SIS compact, 15

## M
- Main entry
  - Communication and interfaces, 35
- Mass Data Engineering
  - OS, 19
- Maximum system configuration
  - SIMATIC SIS compact, 26
- Minimum system configuration
  - SIMATIC SIS compact, 25
- Multiprojects
  - ES, 18

## O
- Operating systems
  - SIMATIC SIS compact, 14
- OS
  - Archiving, 19
  - Interfaces, 20
  - Mass Data Engineering, 19

## P
- Process object
  - SIMATIC SIS compact, 17
Project migration
  SIMATIC SIS compact, 33
Project wizard
  ES, 18
Properties
  SIMATIC SIS compact, 17

R
Remote I/O stations
  SIMATIC SIS compact, 12

S
Safety functions
  SIMATIC SIS compact, 9
SEC
  SIMATIC SIS compact, 12
SIMATIC SIS compact
  Achievable safety requirements, 9
  AS, 11
  bundles, 11
  Communication and interfaces, 35
  Communication security, 31
  CPU, 11
  Fail-safe systems, 9
  Fail-safety and availability, 9
  Gateway, 13
  High-precision time stamping, 12
  Installation, 21
  License Bundles, 15
  License Key USB Hardlock, 15
  Maximum system configuration, 26
  Minimum system configuration, 25
  Operating systems, 14
  Process object, 17
  Project migration, 33
  Properties, 17
  Remote I/O stations, 12
  Safety functions, 9
  SEC, 12
  SIMOCODE, 13
  SINAMICS drives, 13
  Software Packages, 22
SIMOCODE
  SIMATIC SIS compact, 13
SINAMICS drives
  SIMATIC SIS compact, 13
Software Packages
  SIMATIC SIS compact, 22

STEP 7
  User interface, 19

U
  User interface
  STEP 7, 19